UVS Remote
Software for remote communication between
UVS 1500 and PC

User’s Manual
Ver 2.0.12 and later

This manual includes all functions of UVS Remote.
Users of Null modem connection
(standard item delivered with the UVS 1500 Vibration Monitor)
will have access only to functions related to this connection.
# Table of Contents

WELCOME TO UVS REMOTE ......................................................................................................................... 2
  INCLUDED IN THE PROGRAM PACKAGE .......................................................................................... 2
  REGISTRATION CARD ....................................................................................................................... 2

WHAT IS UVS REMOTE? ............................................................................................................................ 3

USE OF THIS MANUAL ............................................................................................................................. 3
  KNOWLEDGE REQUIREMENTS ......................................................................................................... 3
  TYPOGRAPHICAL CONVENTIONS USED ...................................................................................... 3

INSTALLATION OF UVS REMOTE ............................................................................................................. 4
  MINIMUM REQUIREMENTS FOR PC INSTALLATION ..................................................................... 4
  INSTALLING UVS Remote .................................................................................................................. 4

RUNNING UVS REMOTE ........................................................................................................................... 6
  MAIN WINDOW (NOT CONNECTED) ..................................................................................................... 6
  MAIN WINDOW (CONNECTED) ........................................................................................................... 12
  SMS SETUP WINDOW ............................................................................................................................ 14
  SMS MESSAGES .................................................................................................................................. 16
  FILE TRANSFER ........................................................................................................................................ 17

INSTALLATION/SETUP OF THE UVS 1500 ............................................................................................. 19
  NULL MODEM ......................................................................................................................................... 19
  UVS 3800/3801 (PSTN MODEM) INSTALLED INSIDE THE UVS 1500 .............................................. 20
  UVS 3900 WITH GSM MODEM CONNECTED TO THE UVS 1500 .................................................. 21
  UVS 3900 WITH UVS 3800/3801 (PSTN MODEM) INSTALLED ......................................................... 22

TROUBLE SHOOTING ................................................................................................................................. 23
  INSTALLATION OF UVS REMOTE ...................................................................................................... 23
  UVS REMOTE IN USE .......................................................................................................................... 23
Welcome to UVS Remote

Included in the program package

A. The UVS Remote for PC & one UVS 1500 instrument (Part No. 20 7650 00) consists of:
   • A UVS Remote program disk for PC (same as, or latest version of, the disk delivered with your UVS 1500).
   • A UVS 1500 program disk, latest version.
   • A modem with cables for your PC.
   • A modem communication box with a flat RS232 cable for your UVS 1500.
   • Cables and connectors from the modem communication box to a telephone socket, with mounting instructions.
   • This manual
   • A registration card.

B. The UVS Remote for each additional UVS 1500 (Part No. 20 7652 00) consists of:
   • A UVS 1500 program disk, latest version.
   • A modem communication box with a flat RS232 cable for your UVS 1500.
   • Cables and connectors from the modem communication box to a telephone socket, with mounting instructions.

For each UVS 1500 instrument to be connected to a regular (PSTN) telephone line will also need the rechargeable battery option (Part No. 20 8235 00). If you have not purchased it earlier, you will need the rechargeable battery set (Part No. 20 8235 10). (This does not apply to GSM-connected instruments.)

C. The UVS Remote demo version (Part No. 20 7650 01) is included in the UVS 1500 delivery and consists of:
   • A UVS Remote program disk for PC.
   • This manual.

Registration card

Please be sure to fill out and send in your registration card. This will enable us to give you all the support and service you are entitled to.

As a regular owner of UVS equipment you will have access to continuously updated information from the ABEM home page support@abem.se on upgrades and other products that can make your job easier. Please contact ABEM for the current password.
What is UVS Remote?

If you are acquainted with the functions of the UVS 1500, you will find it easy to use the UVS Remote program. It works the same as if you were operating the UVS 1500 directly (except for some specific commands related to modem communications).

The UVS Remote is an extension of your UVS 1500. This means that you do not need to go out in the field to operate the instrument or to read and retrieve data.

We have tried to make the UVS Remote as simple as possible. We, at ABEM Instrument AB in co-operation with Dyno Consult AS and Nitro Consult AB, are continuously testing and upgrading this product in every way possible. It has been commercially used at many construction sites.

UVS Remote uses the modem installed in your PC. Also a GSM phonewith modem functionality installed in your PC can be used (e.g. Ericsson SH 888 or Nokia 3110/6110/6150 with Nokia data suite software).

The Null modem connection via a direct serial cable (standard item delivered with the UVS 1500 Vibration Monitor), does not require modems in PC or UVS 1500.

In the UVS 1500 there are two alternatives available (in addition to Null modem):

1/ The UVS 3801 Modem Box for the Public Switched Telephone Network (PSTN).
2/ The UVS 3900 Communication Unit for wireless GSM functionality.

Use of this Manual

Knowledge requirements

Other than being familiar with Microsoft Windows®, no special knowledge is required for the installation or use of UVS Remote.

If you have never worked with Windows, it is worth spending some time to learn the basics. UVS Remote uses the same principles as Windows with dialog boxes and menus.

Typographical conventions used

The following is an explanation of the typography used in this manual.

CTRL Normally you will see this symbol followed by a plus sign. This means you should press and hold the CTRL key while you press the other key listed (e.g. CTRL + P).

Bold Used for choices and text to be entered in dialog boxes.

Italics Used when giving references, such as figures.

CAPITAL LETTERS Name of a directory or file (e.g. C:UVSR/INSTR.MDB). Commands for UVS 1500 (e.g. Press INFO).
Chapter 1

Installation of UVS Remote

Minimum requirements for PC installation

- A PC with Microsoft Windows® 95/98 or NT4, and a VGA screen.
- At least one UVS 1500.
- If used over the PSTN, a working modem installed in the PC.

Installing UVS Remote

- Make sure that Windows is installed in your computer. If you don’t have the proper Windows version, install it before you start installation of UVS Remote.
- Start Windows. Place the first UVS Remote diskette in drive A or B (or the CD ROM in the appropriate drive). Choose Run from the Windows Start menu. See the example below.

![Figure 1 - Window for the command File - Run](image)

- On the command line, type A:\SETUP if you have your disk in drive A or B:\SETUP if you have your disk in drive B.
- If the software is loaded from the Internet, use the Windows Explorer to run UVSR.EXE to unpack the installation files. Then run SETUP.EXE to install the software.
Once the screen shows the UVS Remote Setup, installation is self-explanatory.

![UVS Remote Setup window](image1)

**Figure 2 - UVS Remote Setup window**

If you attempt to exit setup, figure 3 will appear on the screen.

![Exit Setup](image2)

**Figure 3 - Exit Setup**

During the installation of the program, files are copied to the directory chosen by the program. Also some system files will be copied to the Windows system directory.

When installation is completed, a shortcut named “UVSRemote” will appear under “Programs” in the Windows Start menu.
Running UVS Remote

Start the Program

- Double-click on the UVS Remote icon to start the program.

Main Window (Not Connected)

The main window of UVS Remote will appear after opening. It looks very similar to the front panel of the UVS 1500. You will click the same buttons on the screen that you do on the UVS 1500.

The main window was developed for a VGA screen. With a higher quality screen, you can expect a smaller picture.

Choosing the File menu, you can select Exit to leave the UVS Remote program.
Choosing the **Setup** menu opens a dialog box used to setup the **PC** for UVS Remote.

![PC setup window](image)

**Figure 6 – PC setup window**

**Nullmodem frame:**
Selects communications port for connection via a Null modem cable.

**Modem frame:**
Selects one of the installed modems for connection via a modem. UVS Remote retrieves all necessary information about the modem (com port, setup strings etc.) from the Windows registry. If no modem is installed in the PC, the text “No modem found” will appear.

**Dialing Prefix:**
This information will be added prior to all telephone numbers (e.g. “0W” to call via an office switchboard).

**Alt. Modem Init:**
To set an alternative initiating string to the modem, this string must begin with “AT&F.”. To add parameters to the initialising string, this string must begin with “+”. The modem strings retrieved from the Windows registry is normally enough and do not need to be changed.

**Max BaudRate:**
To limit the baud rate used to communicate with the modem or via the Null modem cable, the maximum allowable baud rate can be entered here.
Low Protocol Level:
Can be used to keep the protocol between the PC and the UVS 1500 running in a mode suitable for half duplex communication equipment (e.g. RS485, radio modems or short distance modems). This mode will slow down the communication rate and shall not be used if not needed.

AutoShow BMP:
If enabled, the last transferred BMP file will be displayed (see section File Transfer later in this manual).

Debug Mode:
If enabled, all commands and responses will be displayed at the bottom of the UVS Remote main window. Also communication debug information will be placed in the file DEBUG.TMP. This file is located in the same folder as the UVS Remote program.

The Options menu in the Main Window has three possible choices:

Sync LCD:
Transfers a new picture from the connected UVS 1500. This is useful if the picture has been distorted (e.g. by poor connection).

LCD to Clipboard:
Transfers the actual picture from the UVS 1500 LCD to the Windows clipboard. From there you can use the Paste command (e.g. to include the picture in a written report).

About UVS Remote:
Will show information of the program version and copyright.

The SMS menu will be discussed later in this manual.
The Instrument Database

All instruments to be used must be registered in the Database. The Database is opened by clicking the LCD button.

![Database setup window](image)

*Figure 8 - Database setup window*

The five buttons at the top have the following functions:

- **CALL**: Initiates the modem and calls up the instrument indicated in the Serial Number box.
- **CANCEL**: Exits the database window without calling an instrument.
- **NEW**: Provides a blank record, with Serial Number as the active field. Information on a new instrument can now be entered.
- **UPDATE**: Updates the database with the new entries.
- **DELETE**: Removes the current record.
Explanation of the database fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Serial Number</strong></td>
<td>Instrument serial number, must always be filled in. It is used in the communication between UVS Remote and the instrument. To select an instrument from the database, click on the list button, then double click on the instrument you choose. You can also type the serial number in the box. The serial number must be the “short form” (3- or 4-digit) number that appears on the LCD (not the full 7-digit number on the S/N panel).</td>
</tr>
<tr>
<td><strong>Phone Number</strong></td>
<td>Telephone number to the instrument. For direct connection via Null modem, leave this field blank. If UVS Remote is used in a mixture of GSM and normal modem connected instruments, it is recommended that the full area code is entered for each instrument.</td>
</tr>
<tr>
<td><strong>Device</strong></td>
<td>The type of communication device <strong>on the instrument side</strong>. If a direct cable is used, select <strong>NULL</strong>. Selecting the wrong device will make it impossible to communicate with the instrument. Information from this field will be used to determine whether the PC will use the communication port selected in the Setup-NullModem frame or the modem selected in the Setup-Modem frame.</td>
</tr>
<tr>
<td><strong>Data Directory</strong></td>
<td>The path to the directory in which your data will be stored. This field must be filled in before you can transfer data. UVS Remote proposes the following path: \C:(Program directory)\DATA(Instrument type)(S/N). You can also select a path by clicking the list button to the right and choosing existing drives and directories.</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>Text field (e.g. for project identification).</td>
</tr>
<tr>
<td><strong>Text 1-4</strong></td>
<td>Text field (could be related to channel numbers).</td>
</tr>
</tbody>
</table>
Calling up an instrument

After you have chosen an instrument, click on the CALL button with the mouse. A new “dialing window” comes up. You should see the following at the top:

- **Init ComPort #**  
  The PC has initiated the calling routine with its own modem.

- **Dialing**  
  After initiating the modem, the program sends the dialling command including the telephone number to the modem.

- **Time out in # s**  
  After dialing, UVS Remote waits for a timeout period until the modems have established a connection. If no connection has been established after the timeout period the PC modem will hang up. If a GSM modem is used at the UVS 1500 end (see later), it is possible to let UVS Remote make several retries before it stops calling. If the line is busy, the modem will hang up after 3 seconds. A CANCEL button is available if you want to hang up manually.

![Dialing, timeout in 50s](image)

*Figure 9 – Dialing window*
Main Window (Connected)

The title bar (above the menu bar) gives you the UVS Remote program name along with the status of the connection with the modem.

- **[Not Connected]** UVS Remote is open, but no instrument has been called.
- **[327, Connected]** Contact has been established and the instrument (number 327) is ready for communication with the PC.
- **[327, Connected, Busy]** Instrument number 327 has been called, but there is no contact with the instrument. The instrument might be busy (recording an event), or the instrument at this telephone number is not number 327.

![UVS Remote (Connected)](image)

**Figure 10 - UVS Remote connected to instrument S/N 629**

The LED on the instrument panel (to the right of the REG button) is indicated as follows on the PC screen:

- **Blank**: Reg off.
- **Semi-filled**: Flashing (scanning mode).
- **Filled**: Steady light (processing after Reg on or trigger).
If UVS Remote is setup in **Debug** mode, the following information can be seen on the bottom line of the main window:

- The left field displays the last command sent to the UVS 1500.
- The number in the middle displays the protocol version in the UVS 1500.
- The right field displays the last response from the UVS 1500.

The blank buttons above REG and the LED indicate the contrast setting buttons on the instrument panel, and have no function in this case.

To send dual button sequences, e.g. REG + NOW for manual triggering, first press the REG button. A red field over the button indicates that the REG button is activated. Then press NOW to initiate sending of the REG + NOW sequence. The REG button can be deactivated by pressing it again.
SMS Setup Window

SMS (Short Message Service) is a feature provided by most GSM operators, whereby short written messages can be sent by one Tele or GSM telephone to one or several GSM telephones. An SMS message is immediately indicated when received by the actual telephone, and can be read directly on the LCD.

The SMS setup is displayed by clicking SMS in the Options menu of the main window.

![Figure 11 – SMS setup window](image)

All editing of SMS receivers etc is made in the PC frame to the left in the window.

After editing the SMS parameters, the parameter set must be transferred to the actual UVS 1500 instrument. This is done by clicking the Right Arrow. If this is the first time an instrument receives SMS parameters, it may take a while.

Default information for the PC frame can be fetched from the currently connected UVS 1500 by using the Left Arrow, or from the PC by clicking the From Disk button (whereby the latest saved PC frame data occurs).

The PC can only accommodate one set of SMS parameters.

To save the PC frame for later reuse, press the To Disk button.

SMS-Operator:
The protocol used by the UVS 1500 to send SMS messages is called UCP (Universal Computer Protocol), command type 30. Enter the phone number to your UCP gateway in this field. Your GSM operator will provide you with the number.

**Receiver 1-8:**
Up to 8 receivers can be listed, but only those with the Active box enabled will receive SMS messages.

A Note of maximum 6 characters can be entered after PhoneNumber fields of the SMS-operator and the Receivers.

If the UVS 1500 program version is 5.0.2H or later, the Note field can be used as a dialing prefix (=extension of the PhoneNumber field), provided that this prefix starts with a 0 (zero). This can be useful e. g. for international connections.

**Location:**
This field is automatically fetched from the Location field of the instrument database, but is changeable if needed.

**Change By:**
To enable your PC to send SMS parameters to the UVS 1500, this field must be filled with a signature of 2 to 4 characters.

**UVS1500 frame:**
This frame displays the current SMS setup of the remote UVS 1500, including date and time for the last changing of the setup.

**On, Off:**
Use these buttons to activate/deactivate the SMS function of the actual UVS 1500 Instrument. The text between the buttons will display the current status.

Many of the SMS parameter actions must be acknowledged by pressing **OK** in message boxes like this.

![Figure 12 – SMS data confirmation window](image-url)
SMS Messages

When the UVS 1500 has triggered and saved an event to memory, and the SMS function is activated, an SMS message like this will be sent to all active receivers:

```
LOCATION A 100#052 TU 14
APR 1998 09:13; 12.4mm/s
2.05mm/s 2.2mm/s 2.05mm/s
```

*Figure 13 – Typical SMS message in mobile phone LCD*

The actual presentation will vary depending on the LCD in your GSM phone.

Normal delay of the GSM operator’s distribution of the message is less then 30 seconds.

- “LOCATION A” is a string fetched from the database of UVS Remote.
- “100” is the Serial Number of the sending instrument.
- “#052” is the number of the event.
- “TU 14” is the day of the week and the date of the event.
- “APR 1998 09:13” is the month, year, hour and minute of the event.
- “2.05mm/s…..” are the maximum values and units for the event (4 channels).
File Transfer

Transfer of files is initiated in the same manner as when operating the instrument directly.

During transfer of data files from the UVS 1500 to the PC, this window appears.

![UVS Remote file transfer window](image)

*Figure 14 - UVS Remote file transfer window*

- **Filename:** GR411758.BMP
- **Path:** C:\PROGRAM FILES\UVSREMOTE\DATA
- **Blocks:** 31 of 68

**Filename:**
- GR = Graph file
- 411 = Instrument S/N
- 758 = Event No.
- BMP = Bitmap file

**Path:** Where the transferred file will be placed.

**Blocks:** Count-up during transfer.
If the transferred file is a BMP-file and **Autoshow BMP** is enabled, this type of windows is displayed when the transfer is complete.

![Graph file presented on PC screen](image)

**Figure 15 – Graph file presented on PC screen**

The “To Clipboard” on the Options bar will copy the graph to the Windows clipboard.
Chapter 4

Installation/Setup of the UVS 1500

Null Modem

The Null modem is the easiest way to use UVS Remote. It gives you the possibility to transfer data to your PC from the UVS 1500 by direct connection.

- You must have a UVS 1500 with program version 4.708 or later. To setup SMS messaging (for later use with PSTN or GSM), version 5.0.1 or later must be installed.
- Connect the UVS 1500 to the PC using the modular cable set delivered with your UVS 1500. The modular connector marked with UVS 1500 must be connected to the UVS 1500, the one marked PC 25-pin or PC 9-pin to your PC.
- Start the UVS 1500 by pressing the LCD key on the instrument.
- Open the INFO menu on the UVS 1500 and set the Remote operation parameter to Null Modem.
- Press F1 to save the new settings.
- The UVS 1500 is now ready for use. UVS 1500 will start automatically then it receives commands from the PC.
UVS 3800/3801 (PSTN modem) installed inside the UVS 1500

The standard software installed in your UVS 1500 is sufficient for using UVS Remote with a modem. However, you will need a UVS 3801 Modem Communication Box with the appropriate cables.

- You must have a UVS 1500 with program version 4.708 or later. To use SMS messaging 5.0.1 or later is required.
- Make sure that the UVS 1500 is prepared for modem use. A small metallic round connector at the left hand side of the lid must be installed.
- Place the UVS 3801 to the left in the lid of the UVS 1500.
- Connect the UVS 3801 RS232 port to the UVS 1500 with the provided ribbon cable.
- Connect the UVS 3801 TELE port to the round connector via the provided modular cables and connector block.
- Make sure that rechargeable batteries (see page 1) are installed in the instrument and charged.
- Connect the telephone line to the round connector of the UVS 1500.
- Start the UVS 1500 by pressing the LCD key on the instrument.
- Open the INFO menu on the UVS 1500 and set the Remote operation parameter to Tele Modem.
- Press F1 to save the new settings.
- The UVS 1500 is now ready for use. UVS 1500 will start automatically then it receives a call from the PC.
UVS Remote

UVS 3900 with GSM modem connected to the UVS 1500

The standard software installed in your UVS 1500 is sufficient for using UVS Remote with a GSM modem. However, you will need a UVS 3900 GSM Communication Unit with the appropriate cables.

- Make sure that program version 5.0.1 or later is installed in the UVS 1500.
- Make sure the UVS 1500 is prepared for use with the UVS 3900. A large plastic round connector at the left side of the instrument must be installed.
- Make sure that the plastic connector is internally connected to the RS232 port of the UVS 1500.
- Place the GSM modem in the UVS 3900 and connect it with the cables provided.
- Make sure the lead acid battery of the UVS 3900 is well charged.
- Set an appropriate operation mode of the UVS 3900 (see UVS 3900 manual).
- The UVS 3900 is independently powered (not from the instrument), which means that rechargeable batteries are not required in the UVS 1500.
- Connect the GSM antenna to the UVS 3900. Place the antenna as high as possible for maximal signal level. A regular GSM phone can be used to search for the best placement of the antenna.
- Connect the UVS 3900 to the UVS 1500 with the cable provided.
- Start the UVS 1500 by pressing the LCD key on the instrument.
- Open the INFO menu on the UVS 1500 and set the Remote operation parameter to GSM Modem.
- Press F1 to save the new settings.
- The UVS 1500 is now ready for use. UVS 1500 will start automatically then it receives a call from the PC.
UVS 3900 with UVS 3800/3801 (PSTN modem) installed

- Make sure that the UVS 1500 is prepared for use with the UVS 3900. A large plastic round connector at the left side of the instrument must be installed.
- Make sure that the plastic connector is internally connected to the RS232 port of the UVS 1500.
- Place the UVS 3801 in the UVS 3900 and connect it with the cables provided.
- Connect the telephone line to the round connector of the UVS 3900.
- Make sure that the lead acid battery of the UVS 3900 is charged.
- The UVS 3900 sets operation mode for the UVS 3800/3801 automatically.
- The UVS 3900 is independently powered (not from the instrument), which means that rechargeable batteries are not required in the UVS 1500.
- Connect the UVS 3900 to the UVS 1500 with the cable provided.
- Start the UVS 1500 by pressing the LCD key on the instrument.
- Open the INFO menu on the UVS 1500 and set the Remote operation parameter to Tele Modem.
- Press F1 to save the new settings.
- The UVS 1500 is now ready for use. UVS 1500 will start automatically then it receives a call from the PC.
Trouble shooting

Installation of UVS Remote

UVS 1500 side:

- When setting up the UVS 1500 for use with the UVS Remote, you should select REMOTE OPERATION: TELE, GSM or NULL in the INFO menu.

- You should be aware that there are several different modular connectors for telephones and modems. Although they may look quite similar, the connectors might communicate through different pins. To avoid problems, be sure to use the modular connectors and cables provided with UVS Remote and the modem.

UVS Remote in use

PC side:

- If you use a fax program on the same modem/port as UVS Remote, you must close this program before you start UVS Remote.

- If you have recently used the serial port under a DOS session, the DOS Windows MUST be completely closed to release the port. This is a known bug/feature of Windows 95/98.

- Poor telephone connection could mean that you cannot contact your instrument. If GSM modems are used, try to mount the antennas in the best possible way. You can terminate the contact procedure by pressing the CANCEL button. When you try to contact the instrument again, you may get a busy signal from the instrument. Wait for 2 minutes and try again.

- When entering a new instrument into the database, be sure that the drive you select really exists on your PC or server.

- If you are using a UVS 1500 program version earlier than 5.0.1F, be careful not to make changes to the REMOTE OPERATION in the INFO menu of the instrument when operating remotely: If the change is saved (via F1) the connection will be cut off, and resetting can only be made directly on the instrument.